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1. Introduction 

1.1. About Fuse Creator™ 
Fuse Creator™ is an intuitive activity-creation tool that is quick and easy to use, requires little 
technical knowledge, and can help you produce professional-looking activities and resources in 
minutes. 
 
With Fuse Creator™ you can: 
 

• Create – set up and create a whole range of new interactive activities from scratch. 
• Edit – open and edit existing activities to tailor them to your needs. 
• Sequence – add branching to an activity so it can be differentiated for all ability levels. 
• Publish – publish activities in a number of different formats at the click of the mouse. 

 
You may wish to use Fuse Creator™ to create quick activities for your lessons on an ad-hoc basis, or 
you could use it to make more in-depth assessments or exercises that will personalise the learning 
experience of all your students. Fuse Creator™ can even be used by students to show that they 
have grasped a particular learning objective enough to teach it to their peers or other learners. 

1.2. How to use this guide 
 
This guide comprises the following sections: 
 

• Installing Fuse Creator™ – describes how to install the software onto your computer. 
• Guided tour – provides a brief overview of all the features of Fuse Creator™. 
• Using Fuse Creator™ to create and edit activities – provides guidance on using Fuse 

Creator™ to create and edit activities including details about page types. 
• Using Fuse Creator™ to sequence activities – provides guidance on using Fuse Creator™ to 

sequence existing pages in an activity, including scoring and feedback. 
• Playback – provides an overview of the playback features available in Fuse Creator™. 
• Saving your activity – provides guidance on saving the activities you have created using 

Fuse Creator™. 
• Publishing activities – provides an overview of the publishing options available in Fuse 

Creator™. 
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1.3. Fuse Player 
Fuse Player is an application which can run Fuse Creator™ .fc files or Fuse Creator™  activities 
published as SCORM packs. 
 
Fuse Player is useful for users who do not have Fuse Creator™ installed. It allows them to run files but 
will not allow them to make any changes to the file. 
 
You can run Fuse Creator™ files in Fuse Player in two ways: 
 

1. From the  File Menu within Fuse Player, click Import Pack. Browse to the Fuse content you 
want to run. When it imports, select the content and click Run.  

2. Double-click an .fc file on a computer which has Fuse Player installed but does not have Fuse 
Creator™ installed. In this case the .fc file will automatically open in Fuse Player.  

 
An installation CD for Fuse Player is included with your Fuse Creator™  software pack. 
 

1.4. Getting support 
 
If you experience problems using Fuse Creator™, or for further help and technical support, you can 
visit the Fuse Creator™ Community Web site, or contact RM Support. 
 
To get help from other users on the Fuse Creator™ Community Web site, visit www.fusecreator.co.uk 
 
To contact RM Support you can either: 

• Visit www.rm.com/support 
• Telephone 0845 404 0000 during office hours 

(Monday – Friday 8 am to 6 pm) 
If telephoning, please have your RM customer ID ready. 
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2. Installing Fuse Creator™ 

This section details the hardware and software you will need before you start to use Fuse Creator™.   

2.1. Technical requirements 
The table below shows the recommended hardware and software required to use Fuse Creator™ to 
create activities: 
 
Operating System Standalone computers using 

Windows® XPSP2 & Windows 
Vista™  and Windows Server® 2003 
with client computers running 
Windows® XPSP2 or Windows 
Vista™  

OS X 10.5.1, 
OS X 10.4.10 

Processor 1GHz+  G4 800MHz+ 
Memory 512MB  512MB 
Storage 100MB 100MB 
Screen 1024x768 1024x768 

 
 
The table below shows the recommended hardware and software needed to run published 
activities using Fuse Player (Fuse Creator™ is not required): 
 
 Microsoft® Windows® Apple Macintosh RM Minibook 
Operating System Standalone computers 

using Windows® 2000, 
Windows®XPSP2 & 
Windows Vista™  and 
Windows Server® 2003 
with client computers 
using Windows® XPSP2 
or Windows Vista™ 

OS X 10.5.1, 
OS X 10.4.10 

Xandros™/Windows® 
XP 

Processor 800Mhz+  G4 800MHz+ 900MHz 
Memory 256MB  256MB+ 256MB 
Screen 800x600 800x600 800x400 
Flash Player Adobe® Flash® Player 

8+ 
Adobe® Flash® 
Player 8+ 

Adobe® Flash® 
Player 8+ 

Browser Microsoft® Internet 
Explorer® 5.5/6.0/7.0, 
Mozilla® Firefox® 2,  
Opera 9 

Apple Safari 1.2,  
Mozilla® Firefox® 2,  
Opera 9 

Mozilla® Firefox® / 
Microsoft® Internet 
Explorer® 
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2.2. Installing Fuse Creator™ on your computer 
The following steps guide you through the process of installing Fuse Creator™. 
 
To install to your Windows®-based or Macintosh-based computer follow the on-screen instructions. 
 
To install to Windows®-based networks, including Community Connect 3 or 4 networks, follow the 
instructions in the Installation Guide. 
 
1. Insert the Fuse Creator™ CD ROM into your computer CD drive. 
2. Follow the procedure for your computer type: 

a)   For Windows® users, the installation wizard should start automatically. If installation does not 
start automatically, locate and select the Setup program on the CD and double-click to 
run. Click Standalone Computer. 

b)   For Macintosh users, locate and select the Setup application on the CD and double-click to 
run. 

3. Follow the installation wizard by choosing the Next button when prompted. 
4. You will be prompted to accept the terms of the licence agreement. Choose I accept … and 

click Next. 
5. Enter your establishment name and the product key, which can be found on the Fuse Creator™ 

pack, and click Next. 
 
Note:  Your establishment name must consist of at least four characters and will be used when you 

publish activities. 
You must enter the product key at this time otherwise Fuse Creator™ will be installed as a 
 demonstration version, which does not support saving and exporting activities. 

 
6. Choose the location on your computer where you want Fuse Creator™ to be installed and click 

Next. 
7. Click Next to have the media files and sample activities install to the default location. 
 
Note:  You can click Back (Windows®) or Previous (Macintosh) to review and/or change the 

settings on each screen. 
 
8. When you have finalised all options, click Install to continue. 
9. Fuse Creator™ will install the necessary files to your computer. When the installation is complete 

click Finish. 
 

 To run Fuse Creator™, click the Fuse Creator icon on your Desktop. 
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3. Guided tour 

3.1. Start page 
When you first open Fuse Creator™, the Start page displays. This gives you three options:  
Create a new activity, Edit an existing activity or Run an activity.   

3.2. Activity Set-Up page 
When you choose the Create option, the Activity Set-Up page displays. This allows you to define the 
activity and some of its parameters. Enter as much information as you can. This helps with tagging 
the activity later on.  

3.3. Creating pages 
When you are starting a new activity from scratch, the initial page shows a panel named ‘Select the 
first page type’. 
 

 
 
There are eight page types available:  
 

• Drag and Drop  
• Ordering  
• Fill the Gap  
• Question  
• Linking Lines  
• Flashcards  
• Information  
• Menu Page   
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You can create as many pages as you like by clicking the New button. Your pages are 
added to the page tray at the bottom of the page. A collection of pages is referred to 
as an activity.  

 

 

3.4. Sequencing activities 
Once you have created the pages of your activity, you can sequence them and 
add branching to them so that different users get a different experience depending 
on their score. You can add comments to a page outcome, dependent on the score 
achieved, and you can also add a final report page to the activity to show users how 
they did in the activity. 

3.5. Previewing your work 
You can preview both your pages and your sequenced activities. The Preview Page 
button in the page editor allows you to test the current page.   

 
 
 

The Run Activity button in the Sequencer allows you to test the fully sequenced 
activity. You can view the page or activity exactly as the intended user will see it.   
 

3.6. Running your activity 
The Playback screen allows you to run the activity as a user will see it. It displays all the functionality 
that you have defined for the activity, including a splash screen with copyright message, prompt for  
name and report pages.  

3.7. Saving your work 
You can save your activity as an editable Fuse Creator™ file to come back to later. You can also 
select Save As…, in order to create different versions with slightly different content or structure by 
changing the file name. 

3.8. Publishing 
You can publish Fuse Creator™ activities in the following ways: 
 

• Publish Standalone – this feature allows you to publish the current activity as an .html or .swf 
file to be played back on a computer or via a web site. 
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• Export SCORM – this feature allows you to publish the current activity as a SCORM pack for 
use in a VLE. 

3.9. File Menu 
The File Menu on the main navigation bar at the top of the Fuse Creator™ 
window provides the following options: 
 

• Create New… – allows you to create a new activity. 
• Open Activity… – allows you to open an existing activity. 
• Sample Activities… – allows direct access to the sample files provided. 
• Save – allows you to save the current activity. 
• Save As… – allows you to save the current activity under a different file name. 
• Import SCORM… – allows import of SCORM files produced in Fuse Creator™. 
• Export SCORM… – allows you to publish the current activity in either SCORM 1.2 or SCORM 

2004 formats. 
• Publish Standalone… – allows you to publish the current activity as a standalone activity, 

which can be copied to other computers. 
• Activity Set-Up… – allows you to add some basic and advanced details to describe the 

activity. 
• Exit – allows you to exit the application. 

3.10. Help Menu 
The Help Menu on the main navigation bar at the top of the Fuse Creator™ 
window provides the following options. 
 

• Help – opens the Help file which covers the features of Fuse Creator™ and includes a quick 
tutorial. 

• User Guide – opens a copy of this guide which you can print out. 
• Creator Web Site – allows you to open the Fuse Creator™ web site. 
• About Creator… – allows you to view detailed product information such as copyright, version 

and product type. There are also links to product and company web sites and a link to the 
licence agreement for Fuse Creator™. 
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4. Using Fuse Creator™ to create and edit activities 

4.1. Start page 
The start page, when active, displays every time you run Fuse Creator™.   
 
 

 
 
This page provides a quick route to the main features of Fuse Creator™:  
 

• To create a new activity, click Create. The Activity Set-Up panel displays.  
 

• If you want to edit an existing activity, click Edit, then browse to the location of the activity 
on your computer and click Open. 

 
• If you want to run an existing activity, click Run, then browse to the location of your 

sequenced activity on your computer and click Open. 
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4.2. Activity Set-Up  
This palette allows you to define the activity you want to create. The information you provide here 
will help when it comes to tagging and publishing the activity later on.  

4.2.1. Basic Set-Up 

 
 
 
 
There are two fields that must be filled in – 
Title and Description.  
Type the information into the associated text 
boxes. 
 
 
 
 
 
 
 

4.2.2. Advanced Set-Up 

This tab contains six optional fields: 
 
Keywords – type some keywords here to aid 
discovery of the activity within a Virtual 
Learning Environment (VLE). Keywords should 
be separated by a semi-colon. 
Copyright text – type some copyright text to 
display when the activity is opened and on 
the activity splash screen if required.  
Show copyright in activity – a tick box 
indicating whether you want the copyright 
text to show on the activity splash screen. 
Request user name – a tick box indicating 
whether you want the user to enter their 
name at the start of the activity. Their name 
will be included in their report if this option is 
selected. By default this option is ticked. 

Cost – a tick box indicating whether this activity is a commercially-produced activity and has a cost 
associated with it.  
Protect from edit – a tick box indicating whether you want to prevent this activity from being edited 
once it has been published.  

Once you have completed the required information for Activity Set-Up, you can start to create your 
activity (a sample activity is shown on the following page). 
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4.3. Edit Page  
 

 
 
You create activity pages in the page editor by placing interactive and static objects onto the 
page from the Objects panel. Some of the objects are specific to a particular type of activity and 
some are common to all activity types. Each object can contain one or more pieces of content 
(text, image and audio files) that you source or produce yourself. You can see which types of 
content can be associated with an object by viewing the icons at the base of the object. 
 
The first thing you need to do is select the type of page you want to create from the ‘Select the first 
page type’ panel. There are eight types to choose from, described below. 
 
 

4.3.1. Drag and Drop  

Drag and Drop requires the user to match one set of items to another. Objects can be laid out in 
rows or can be positioned around an image (such as a map or diagram) to become a labelling 
exercise. Red herrings can be added (i.e. dummy drag items).  

4.3.2. Ordering  

Ordering requires the user to place a number of items in the correct order by clicking and dragging 
them into place. This page type can be used for mathematical or scientific equations, or for 
ordering processes or historical events. 
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4.3.3. Fill the Gap 

Fill the Gap requires the user to complete a word, sentence or paragraph by filling in one or more 
missing words or letters. They can do this either by using a pre-determined word bank, or by typing 
the answer into a text box. A different word bank can be set up for each gap, or you can use the 
same word bank for all gaps.  

4.3.4. Question 

The Question page requires the user to complete a multiple choice question. Questions can have 
multiple correct answers if necessary, and can be accompanied by an image, audio or video. The 
user must identify the correct number of answers before clicking the Next button. 

4.3.5. Linking Lines 

Linking Lines presents users with two sets of items. Users link each item in one set with an item in the 
other set using a connecting line. As with the Drag and Drop page, items can be laid out in simple 
rows or can be positioned around an image (such as a map or diagram) to become a labelling 
exercise. Items can have images, audio or text assigned to them. 

4.3.6. Flashcards 

The Flashcards page is intended as a warm-up page to be used on a whiteboard. It presents a 
series of images which the group can discuss. Each image can be assigned some clue text (e.g. the 
first letter of a word, or a written clue to prompt discussion). Clicking the Show answer button reveals 
the correct word/answer. Images can also be accompanied by audio files as required. 

4.3.7. Information  

The Information page is designed to allow you to present a non-interactive page comprising media 
files or some basic information to introduce the activity. The Information page can include any 
combination of the main page objects – audio files, images or text boxes. 

4.3.8. Menu Page 

The Menu Page is designed to allow the user to progress through the activity by choosing their route 
through the pages. You can use it to create an interactive story, where the user chooses what 
happens next by clicking one of the options; or you could use it to allow users to concentrate on a 
particular topic within a bigger activity (e.g. choosing triangles within an activity about polygons). 
 
Once you have chosen the page type you want to create, click its name to start editing and to 
access the main editing tools.  

4.4. Editing tools 

4.4.1. Editable page titles 

The activity title you provided during activity set-up automatically displays on each page, but you 
can change this for each page by selecting the title and typing over it.  
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There is also an optional page subtitle, which can be changed for each page. If no subtitle is 
added, a subtitle will not be shown in the finished activity. 

4.4.2. Objects panel 

 
 
 
The Objects panel contains the objects available for you to use in the page  
type you have chosen. Images, text boxes, input boxes and background 
images can be added to all page types. In addition to these, each page type 
has its own specific interactive objects (see sections 4.7 to 4.13). 
 
 
 
 
 

4.4.3. Page Options panel 

The Page Options panel allows you to change the properties and add features 
to the objects and media files you add to your page, e.g. changing the font of 
text in a text box, resizing an image, etc. 
 
The properties available in the Page Options panel change according to the 
object or media file you currently have selected on the page. 
 
 
 
 
 

4.4.4. New  button 

Click the New button when you want to add a new page to your activity. The ‘Select 
the first page type’ panel reappears, and you can select a new page type, choose to 
insert a page from another activity or duplicate the page you have just finished 
creating.  

 
The Insert page from other activity option allows you to 
browse for an existing Fuse Creator™ file and copy a 
page from it into your open activity. 
 
The Duplicate current page option duplicates the page, 
including all the objects and media files you added to 
the page. 
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4.4.5. Labels button 

The Labels button allows you to view the authoring labels associated with the objects 
you have dragged onto the page. This allows you to see the order of items or matching 
pairs more easily while editing your activity. Labels are not shown in the finished activity. 

4.4.6. Preview button 

You can preview a page from your activity at any time by clicking the Preview button. 
You can then view the page as a student will see it.  
 

4.4.7. Add help 

The Add help button allows you to add instructions / help text to your page to help the 
user complete the activity. The text you add here displays in the activity player when the 
user runs the activity. 
 

The user accesses the help by clicking the corresponding Help button at the bottom the page. 

4.4.8. Show grid 

Click the Show grid button to display a grid on the working page and help you align the 
objects. All objects you add to the working page will ‘snap to grid’ to make positioning 
easier. The grid does not display in the finished activity. 

4.4.9. Recycle bin 

When you want to delete an object from the page, select the object and click the Recycle 
bin icon. You can also use the Delete key on your keyboard to delete objects. 
 
 

4.5. Generic page objects 

4.5.1. Image object 

This object allows you to add an image or a Flash movie file (.swf) to the page, either as 
supporting information or to form part of your activity.   
 

Note:  Any .swf file that you add must be self contained and not access any external files.  
 
To add an image to your page: 
 

1. In the Objects panel, click the Image icon, hold the mouse button down and drag the 
image object; release the mouse button to drop the object onto the page.  

2. The Select File dialog box displays. 
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3. By default the Select File dialog box opens in the ‘Fuse Creator Media’ location. You can 
choose a different location using the navigation panel on the left or the Look in drop-down 
box.   

4. You can choose to open either a .jpg, jpeg or a .swf file by selecting the appropriate file 
type in the Files of type: drop-down box. When you have selected your file, click Open.  

 
Note:  Some images will be larger than the destination image object; if prompted, you can still 

choose to continue adding the image smaller than actual size or choose a different image.  
You can resize the image later (see below). 

 
You can reposition the image by clicking and dragging it to a different position.  

Selection points 

Image icon 
 

You can resize the image box using selection points on the corners and sides of the object. 
 
The image is forced into the proportions of the image box in the first instance, but you can change 
this to suit your requirements by using the image options in the Image Options panel, which displays 
when you click the Image icon below the object.  

 
Change Image – choose this option if you want to change the image file 
assigned to the object. The Change Image option displays the Load Image 
dialog box; click Browse to navigate to another image file or click Cancel. 
 
Remove Image – choose this option if you want to remove the image file 
assigned to the object. 
 
Actual Size – choose this option to resize the object to the original size of the 
image.  
 
Keep Aspect – choose this option to shrink the image to fit the object size, while 

           keeping the original proportions of the image. 
 
You can also add images to other generic objects of different types. To add an image to an object, 
click the Image icon at the base of the object. 
 

4.5.2. Background image object 

This object allows you to add a background image to the page, either as supporting 
information or to form part of your activity.  
 

To add a background image to your page: 
 

1. In the Objects panel, click the Background image icon.  
2. The Select File dialog box displays. 
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3.  By default the Select File dialog box opens in the ‘Fuse Creator Media’ location. You can 

choose a different location using the navigation panel on the left or the Look in drop-down 
box. When you have selected your file, click Open.  

 
Note:   Some images will be larger than the destination image object; if prompted, you can still 

choose to continue or choose a different image. Large images may make the page run 
slowly. 

 
The image is forced into the proportions of the background in the first instance, but you can resize 
the image using the selection points on the corners and sides of the image. The background has a 
width of 796 pixels and a height of 389 pixels. 
 
Select Background –  once you’ve added a background image, the Select Background tab 

becomes active (located at the top of the page). This is how you select the 
background to make changes to it. If the background is deleted, the tab 
becomes inactive.   

 
Deselect Background – once a background image has been added and selected, you can lock 

the image to the page by clicking this tab.  
 

4.5.3. Text box object 

This object allows you to add some text to the page, either as supporting information or 
instructions for your activity. 

 
To add a Text box object to your page: 
 

1. In the Objects panel, click the Text box icon, hold the mouse button down and drag the Text 
box object; release the mouse button to drop the object onto the page. 

2. Double-click inside the text box to type or click the Text icon attached to the Text box 
object.  

 
To delete the text in the text box at any time without deleting the object itself, first select the text 
and then press the Delete key on your keyboard.  
 
To delete the Text box object, click the object to select it, then click the Recycle bin icon 
or press the Delete key. 

 
 
 
 
 
 
 
 

Selection points 

Text icon 

You can edit the text in the Text box object by first selecting the text and then typing over the 
existing text. 
 
You can reposition the Text box object by clicking and dragging the object to a different position. 
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You can re
 
You can c the properties of your Text box using the tools in the Text Options panel, which are 
shown whe

Size and colour – you can resize the text by clicking the graduated buttons 

 

horizontal and vertical alignment options. 
 

d fonts for your text. 
 

t, click the Text icon at the base of the object. 
 

size the Text box object using selection points on the corners and sides of the object. 

hange 
n you click the Text icon below the object.   

 

for small to large text. To change the colour of the text, click the Colour 
Picker icon. 

Alignment – you can change the alignment of the text by using the 

Font – you can choose from four pre-define

You can also add text to other generic objects of different types. To add 
text to an objec

4.5.4. User input box 

This object provides the user with a text entry box, either to answer an open-ended 
question, or to provide workings or reasons for their answer. There can be one input 
box per page. 

 
To add an input box to your page: 
 

1. In the Objects panel, click the User input box icon, hold the mouse button down and drag 
the User input box object; release the mouse button to drop the object onto the page. 

2. Double-click inside the box to type some initial text as instruction text or as a part-finished 
sentence or paragraph. Alternatively, you can delete the text and make it a blank input box 
with instructions elsewhere on the page. 

 
To delete the text in the input box, without deleting the object itself, first select the text and then 
press the Delete key on your keyboard. 
 
To delete the User input box object, click the object to select it, then, click the Recycle bin  
icon or press the Delete key.  
 

 
 
 
 
 
 
You can reposition the input box by clicking and dragging the object to a 
different position. 

Selection points 

Text icon 

 
You can resize your User input box using the selection points on the corners and sides of the object. 
 
You can change the properties of the text in your User input box using the options in the Text Options 
panel. These are the same options as for the Text box object, described in section 4.5.3.  
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4.6. General page properties control 

4.6.1. Page properties 

Each page has its own properties and options to change them. You can access the Page Options 
panel at any time by clicking on the page away from any objects. 

 
Background colour – you can add colour to the background of the page as an 
alternative to a background image. A small colour swatch in the Page Options 
panel shows the currently selected background colour. Click the Colour Picker 
icon to select a new colour. 
 
Activity border colour – you can also change the colour of the header and 
toolbar in the activity player. A small colour swatch in the Page Options panel 
shows the currently selected activity border colour. Click the Colour Picker icon 
to select a new colour. Click the Preview button to view your changes to the 
toolbar. 
 

 
Show back button – you can also define whether your page should show a Back button on the 
toolbar. This is a useful feature for an Information page or Flashcards page, so that users can 
navigate backwards and forwards through the information provided. 

4.6.2. Common object properties 

Most of the objects in Fuse Creator™ have similar properties that you can change from the Frame 
Options panel when you have the object selected. 

 
Border – you can change the border thickness by clicking the Border icons 
representing no border and varying degrees of thickness. A tick indicates which 
option is selected.  
 
You can change the border colour. The small colour swatch in the Frame 
Options panel shows the currently selected colour. Click the Colour Picker icon 
to choose a new colour. 
 
Background – you can choose to have a background to your object by clicking 
the on or off icons. A tick shows the current selection. If you choose to have no 
background then the background of the whole activity is visible through the 

object. If you choose to have a background then you can choose a colour for the object 
background. The small colour swatch in the Frame Options panel shows the currently selected 
colour. Click the Colour Picker icon to choose a new colour. 
 
Resize All – this is available for some of the specific page type objects. Choose this option to resize 
all the objects of the same type on the page. First select the object that is the correct size and then 
click Resize All. All the objects on the page are then resized to the same size. 
 
Resize Pair – choose this option to resize paired objects on the page. First select the object that is the 
correct size and then click Resize Pair. The paired object is then resized. 
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4.6.3. Audio options 

Most objects can have audio assigned to them (MP3 sound files).  
 
To add audio to an object: 
 

1. Click the Audio icon at the base of the object. 
2. A Select File dialog box displays. 
3. By default the Select File dialog box opens in the ‘Fuse Creator Media’ 

location. You can choose a different location using the navigation panel on 
the left or the Look in drop-down box.   

4. When you have selected your file, click Open.  
 

Note:   Some audio files are large; if prompted, you can still choose to continue or choose a 
different audio file. Large audio files may make the page run slowly; you should if possible 
edit the file to reduce its size. 

 
The audio has a number of properties which can be changed in the Audio Options panel when you 
have the Audio icon selected.  

 
Change Audio – choose this option if you want to change the audio file 
associated with the object. The Change Audio option displays the Load Audio 
dialog box; click Browse to choose another audio file or click Cancel. 
 
Remove Audio – choose this option if you want to remove the audio file 
associated with the object. 
 
Size and colour – you can resize the Audio icon to be shown on the selected 
object by clicking on the graduated buttons for small to large icon. The small 
colour swatch in the Audio Options panel shows the currently selected colour. 
Click the Colour Picker icon to choose a new colour.  
 

Alignment – you can change the alignment of the Audio icon by using the horizontal and vertical 
alignment buttons. 
 
Preview audio – choose this option to hear the audio file you have attached to the object. Click the 
Preview audio icon to listen to the audio file. Click the Preview audio icon again at any time to stop 
playing the audio file. 

4.7. Drag and Drop page objects 
The objects and options below are specific to the Drag and Drop page type.  

4.7.1. Drag / Drop pair object 

This object is a pair of linked items that the user matches correctly to complete the 
page. You can choose to have two lines of items or arrange the items around a 

larger image to produce a labelling exercise (see the examples below). 
 
To add a Drag/Drop object to your page: 
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1. In the Objects panel, click the Drag/drop pair icon, hold the mouse button down and drag 
the object, release the mouse button to drop the object onto the page. 

2. When the paired object has been added to the page, if you click one of the paired objects, 
an animated border line shows you where the corresponding item is located.  

 
Remember also that you can use the Labels button to show which object is the 
drag item and which is the drop zone. 
 
 

You can assign text, image, audio or a combination of all three to either the drag item object or the 
drop zone object using the associated icons below the object (shown when the object is selected).  
 

Drag item 

Selection points 

Drop zone 

You can reposition the drag item or drop zone objects by clicking and dragging the object to a 
different position.  
 
You can resize the drag item and drop zone objects using the selection points on the corners and 
sides of the object. 
 

You can reposition and resize the two items independently. 
 
To delete a Drag and Drop pair, click either the drag item or the drop zone to 
select the pair, then click the Recycle bin icon or press the Delete key 
on your keyboard. 
 
You can change the properties of your drag item or drop zone objects 
using the tools in the Frame Options panel, which are shown when you select 
either of the Drag and Drop pair.  
 
 

 
The Drag and Drop objects support the common object properties Border and Background 
(described in section 4.6.2). 
 
With drag item selected: 
 
Resize All – choose this option to resize all the Drag and Drop objects on the page so that they are 
the same size as the one you have selected. This can be used to ensure that users aren’t given clues 
to matching pairs by their size. 
 
Resize Pair – choose this option to resize the matching drop zone object so that it is the same size as 
the drag object you have selected. 
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With the drop zone item selected: 

 
Labelling line – choose this option to add a labelling line to your drop zone 
object. This is useful when you are making a labelling exercise. 

 
Click the tick box on the left of the line.  
 
If you want to add an arrow to the end of your labelling line, click the tick box to the right on the 
line. There is a small colour swatch to the right of the line showing the currently selected colour. To 
change the colour of the arrow, click the Colour Picker icon next to the labelling line option. 
 

4.7.2. Dummy drag object (red herring) 

This object allows you to add some incorrect answers or ‘red herrings’ to your Drag and 
Drop page. It is essentially a drag item with no drop zone. 

 
To add a dummy drag object to your page:  
 

1. In the Objects panel, click the Dummy drag icon, hold the mouse button down and drag the 
object; release the mouse button to drop the object onto the page. 

2. You can assign text, image, audio or a combination of all three to the Dummy drag object. 
 
 

different position. 
 

es of 
the object. 

To delete the Dumm en click the Recycle bin
e Delete key on your keyboard. 

 tools in 
e Frame Options panel, which are shown when you select the object. 

mmon object properties Border and 
ackground (described in section 4.6.2).  

n be 
used to ensure that users aren’t given clues to matching pairs by their size. 

4.8. Ordering page objects 
g page type. You can choose to add 

either a horizontal or vertical ordering object to your page. 

You can reposition the Dummy drag object by clicking and dragging the object to a 

You can resize the object by using the selection points on the corners and sid

 
y drag object, click the object th  icon or press 

th
 
You can change the properties of your Dummy drag objects using the
th
 
The Dummy drag objects support the co
B
 
 
Resize All – choose this option to resize all the Drag and Drop objects on the 
page so that they are the same size as the one you have selected. This ca

The objects and options below are specific to the Orderin
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4.8.1. Horizontal ordering group object 

This object is a group of items in a horizontal line. The user must place the items in 
the correct order by rearranging them horizontally. This group works best for image-
based exercises. 

 
To add a Horizontal ordering object to your page: 
 

1. In the Objects panel, click the Horizontal ordering group icon, hold the mouse button down 
and drag the object; release the mouse button to drop the object onto the page.  

2. The Item Count palette displays. Click the right and left arrows to increase or decrease the 
number of items in the group.   

 
 

Note:  You must have at least two and no more than eight items per page.  
 

3. You can assign text, image, audio or a combination of all three to each of the items within 
the group using the icons below the object (shown as each item in the group is selected). 

4. When editing the page, put the items together in the correct order. The order is randomised 
when the user runs the activity.  

 Selection points 
 
 
You can view this by clicking the Preview button. 
 
 
You can change the amount of items in the group at any time by clicking 
Change in the Frame Options panel (this displays the Item Count palette again).  
 
You can reposition the object by clicking and dragging the group object to a 
different position. 
 
You can resize the object using the selection points on the corners and sides of 

the object. All items are resized together as a group. 
 
To delete the ordering group, click any item in the group to select the group, then click the 
Recycle bin icon or press the Delete key on your keyboard. 
 
The ordering objects support the common object properties Border and Background 
(described in section 4.6.2).  
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4.8.2. Vertical ordering group object 

This object is a group of items in a vertical line. The user places the items in the correct 
order by rearranging them vertically. This group works best for text-based exercises. 
 

To add
 

 a vertical ordering group object to your page: 

1. In the Objects panel, click the Vertical ordering group icon, hold the mouse button down 
and drag the object; release the mouse button to drop the object onto the page.  

2. The Item Count palette displays. Click the right and left arrows to increase or decrease the 
number of items in the group.   

 
 

Note:  You must have at least two and no more than eight items per page.  
 
3. You can assign text, image, audio or a combination of all three to each of the items within 

the group using the icons below the object (shown as each item in the group is selected). 
4. When editing the page, put the items together in the correct order. The order is randomised 

when the student runs the activity.  
 

You can reposition the object by clicking and dragging the 
group object to a different position. 

ll items are resized together 
as a group.  

You can vi icking the Preview button. 

 

 

 
 
 
 

You can resize the object using the selection points on the 
corners and sides of the object. A

 
ew this by cl

 
To delete the ordering group, click any item in the group to select the 

roup, then click the Recycle bin icon or press the Delete key. g
 
You can change the properties of your ordering objects using the tools in the 
rame Options panel, which are shown when you select the object. F

 
The ordering objects support the common object properties Border and 

ackground (described in section 4.6.2). B
 
Change – choose this option to change the number of items in your ordering 
object. It displays the Item Count palette box again. 
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4.9. Fill the Gap page objects 
The objects and options below are specific to the Fill the Gap page type. 

4.9.1. Gap fill text object 

This object is a text box for you to enter words, sentences or paragraphs and create 
missing words or letters for users to complete.  

 
To add a Fill the Gap text object to your page: 
 
1. In the Objects panel, click the Gap fill text object icon, hold the mouse button down and 

drag the object; release the mouse button to drop the object onto the page.  
2. Double-click inside the text box to type or click the Text icon 

to select, then type the word, sentence or paragraph that 
you want to use in the activity.  

 

Text icon 

3. Once you have entered your text, 
while the text is still selected you can 
change the text properties using the 
formatting options in the Text Options 
panel; you can change the text size 
and colour as well as choose from the four preset fonts.  
You may also wish to resize the Gap fill text object at this point, as 
once you move to the next step to create the required gaps you 
cannot edit the text without losing any gaps you have created.  

 
 

 
4. When you are happy with the text, click the Make gaps button 

below the object. (If you need to edit the text again, the Edit 
text button is available.) 

 
5. To make a missing word or letter, select a word or character with 

the mouse. The Select text button changes to a Make gap 
button. Click the Make gap button below the object. 

 
 
6. The Gap Options palette displays. You have options to let your 

user type the answer for each gap, or choose words or letters 
from a word bank to fill the gap.  
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7. Within the palette you have several options: 
 

 
 

Use answer items for all gaps on this page – selecting this allows the user to select all answers 
from a single word bank for the 
activity. This means that you do not 
need to set up a different word bank 
for each gap. 
 
Use answer items for this gap only – 
selecting this allows the user to select 
the answers for each gap from a 
separate word bank. The options are 
presented to the user in a pop-up palette.  
 

Note:  If you choose one of the word bank options, each word or character becomes a clickable 
button for the user.  

 
Use keyboard input – selecting this allows users to type in their answers. 
 
Allow accented characters – for use 
with keyboard input, the tick box is 
ticked by default. When enabled, a 
panel displays for the user to select the 
required accented characters while 
completing the activity. If you do not 
want this feature, click the tick box to 
deselect it. 

 
Remove Gap – allows you to remove 
the current gap from the Gap fill 
object. 
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OK – when you have finished completing the selections for the gap, click OK to save your 
edits. 

 
Cancel – if you want to cancel the action or discard your editing click Cancel. 
The Gap Options palette closes when you click OK or Cancel. 

 
8.  Select the next word or character where you want to create a gap and repeat from step 4, 

until all gaps have been created. 
9. To preview the activity, click the Preview button. 

 
 
The Gap fill text objects support the common object properties Border and Background (described 
in section 4.6.2). 

4.10. Question page objects 
The objects and options below are specific to the Question page type. 

4.10.1.Question object 

This object is a multiple choice answer selection box. When used alongside a text box 
containing some question text, it aims to create a multiple choice page to test user 
knowledge. 

 
To add a Question object to your page: 
 

1. In the Objects panel, click the Question object icon, hold the mouse button down and drag 
the object, release the mouse button to drop the object onto the page.  

2. You can assign text, image, audio or a combination of all three to the Question object using 
the icons below the object. 

3. Add further Question objects in the same way until you have enough choices. 
4. Each object has a selection tick box against each answer; you need to identify the correct 

answer and select Mark as correct in the Frame Options panel.  
5. Actual questions to be used in the activity and any associated images should be added as 

common text box objects or image boxes.  
 

Note:  There must be at least one correct answer per page; you may have more than one correct 
answer.  

 
You can reposition the object by clicking and dragging the object to a 
different position.   

 
You can resize the Question object using the selection 

oints on the corners and sides of the object. 

it, then click the 
ecycle bin icon or press the Delete key on your keyboard. 

tools in the 
rame Options panel, which are shown when you select the object. 

p
 
To delete the Question object, click the object to select 
R
 
You can change the properties of your Question objects using the 
F
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erties Border, Background and Resize All 
(described in section 4.6.2). 

4.11. Linking Lines page objects 
The objects and options below are specific to the Linking Lines page type. 

4.11.1.Linking

f items, or arrange the 
items around a larger image to produce a labelling exercise. 

o add a Linking Lines object to your page: 

on down 

aired objects, 

 Labels button to 

 or a combination of all three to the Linking Lines objects 
using the icons below the object.  

You can reposition the object by clicking and dragging the 

 
bject using the selection points on the 

corners and sides of the object.  

osition a
 

To delete the Linkin
select the pair, then

cific anchor point for both 
e line start and the line end pair. You can choose to show a central anchor 

inking Lines objects support the common object properties Border, 
Background, Resize All and Resize Pair (described in section 4.6.2). 
 
 

 

Question objects support the common object prop

 Lines pair object 

This object is a pair of items that the user has to link via a connecting line to complete 
the page. You can choose to have two rows or columns o

 
T
 

1. In the Objects panel, click the Linking lines pair object icon, hold the mouse butt
and drag the object; release the mouse button to drop the object onto the page.  

2. Once the paired object has been added to the page, if you click one of the p
an animated border line shows you where the corresponding line start or line 
end item is located. Remember also that you can use the
show which object is the line start and which is the line end. 

3. You can assign text, image, audio

 

object to a different position.   

You can resize the o

 
You can rep nd resize the two items independently. 

g Lines pair, click either the line start object or the line end object to 
 click the Recycle bin icon or press the Delete key on your keyboard. 

 
You can change the properties of your Linking Lines objects using the tools in 
the Frame Options panel, which are shown when you select the object. 
 
Anchor Point – click one of the icons to select a spe
th
point, or have left, right, top or bottom anchor points. When you click an option, 
a tick displays to show which option is selected. 
 
L
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4.12. Flashcards page objects 
The objects and options below are specific to the Flashcards page type. 

 
 

4.12.1.Flashcards object 

The Flashcards object is an image on a card with some clue text and answer text. It can be used to 
introduce new topics, themes or vocabulary and encourage discussion. 
 
To add a Flashcards object to your page: 
 

1. In the Objects panel, click the Flashcards object icon, hold the 
mouse button down and drag the object; release the mouse 
button to drop the object onto the page.  

2. The Flashcards object consists of two areas: the prompt area, at 

e and answer text that you add, 

n them.  
. Click the Edit clue icon to edit the text for your clue. Then double-

click in the text box or click the Text icon to type in your text. 

click in the text box to type in your text or click the Text icon. 

ou can resize the object using the selection points on the corners and sides of the object.  
 
To delete the Flashc ss the 
Delete key on your keyboard. 
 
 

You can change the properties of your Flashcards object using the tools in the 
rame Options panel, which are shown when you select the object. 

 

 

Clue text is shown on the Flashcards object automatically or, if the card is face 
down, it displays when the user clicks the object. If no clue text is added, the 

the top of the card; and the reveal area at the bottom of the 
card. Click each area to edit it.  

3. You can assign text, image, audio or a combination of all three to 
the prompt area of the Flashcards object using the icons attached 
to the object.   

4. The reveal area holds both the clu
but only one of them is displayed at a time. Use the Edit clue icon 
and Edit answer icon to toggle betwee

5

6. Click the Edit answer icon to edit the correct answer. Then double-

 
 
You can reposition the object by clicking and dragging the object to a 
different position.   
 
Y

ards object, click the object, then click the Recycle bin icon or pre

F

Flashcards objects support the common object properties Border, Background 
and Resize All (described in section 4.6.2). 
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text area remains e
base of the card. 

fine whether your page should show 

that the card starts 
ce down in the activity. When the user clicks the card, it flips over showing the 
age. By default Flashcards objects are shown facing up. 

 

4.13. Menu Page objects 
ns below are specific to the Menu Page type. 

4.13.1.Link o

tory where the user chooses what happens next, or it can be used to 
ked pages are assigned once you 

bjects on each menu page. 

mpty. Answer text displays when the user clicks the Show Answer icon at the 

Show back button – this option is shown in the Page Options panel when you 
have the page selected. It allows you to de
a Back button on the toolbar. It allows users to navigate backwards and 
forwards to review the Flashcards objects. 

Show cards face down – this option is shown in the Page Options panel when 
you have the page selected. Selecting this option means 
fa
im

 

The objects and optio

bject 

This object acts as a link to a new page in the activity. It can be used to make an 
interactive s
guide the activity down a particular route. These lin

get to the Sequencer.  
 

ote:  There can be up to ten link oN
 

To add a Link object to your page: 
 

1. 

 item.   

ee.  

bject to a different position.   

o delete the Link object, click the object to select it, then click the Recycle bin icon or press the 

In the Objects panel, click the Link object icon, hold the 
mouse button down and drag the object; release the 
mouse button to drop the object onto the page.  
When you add a Link object to the page, it is assigned a 
letter, e.g. first added ‘a’, second added ‘b’, third added ‘c’ up to ‘j’ for the tenth

2. Click the Labels button to display the letter associated with each link in the 
menu and make the sequence easier to s

3. You can assign text, image, audio or a combination of all three to the Link 
object using the icons below the object.  

 
ou can reposition the object by clicking and dragging the Y

o
 
You can resize the object using the selection points on the 
corners and sides of the object.  
 
 
 
T
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Delete key. If you de
 
 

nk object using the tools in th e 
ptions panel, which are shown when you select the object. 

ink objects support the common object properties Border, Background and 
esize All (described in section 4.6.2). 

 

how back button – this option is shown in the Page Options panel when you 
have the Menu Page selected. It allows you to define whether your page shows 
a Back button on the toolbar. It allows users to navigate backwards and 
forwards to review the information. 
 

lete a Link object, the remaining objects are re-lettered, starting again with ‘a’. 

 
You can change the properties of your Li e Fram
O
 
L
R
 

 
 
 

 
 
 
S
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5. Using Fuse Creator™ to sequence activities  

Once you have created your pages, use the Sequencer to structure them into an activity. 

5.1. About sequencing 
 

ays you can sequence an activity: a simple linear sequence and a branched 

re able to add more dimensions to your activity. You can make 
ranches based on the score a user gets and make the experience more personal. For example, a 

Drag and Drop activity has a potential score of eight. For users who get four or less, you may want 

 
There are two w
sequence. 

 
A simple linear sequence can be achieved by clicking the Create linear sequence 
button. The pages of your activity display in a linear sequence in the same order as 
they are shown in the page tray. Every student will go through the activity pages in 

the same order. 
 
In a branched sequence, you a
b



 

© 2008, 3T Productions Ltd and RM Education plc                                                                                         Page 34 of 42 
 
 

 
them to take another look at the topic in question so you could branch them to a Flashcards activity 
to help them revise the topic. For those users who get five and above in the Drag and Drop, you 
may want to congratulate them and progress them to a more difficult page. You have created two 

ranches from a single activity. 

 
anism in Sequencer and that is to use a Menu 
 separate pages in the sequence by branching. 

t the route:  a, b, c… 
d. 

5.2. How to sequence your activity 
e following steps guide you through the process of sequencing your activity. 

ncer somewhere below the first page. 
e bottom of the first 

er below the first page or the 
second

6. Drag a o join to the third page. 
7. You ca

Comm ting line; 
release

alette you have a number 
of options: 

 Show score – selecting this allows the 
 The 

.  
his allows 

the user to have another attempt to 
activity and improve 

their score. This option is not selected 

8. Click OK when you have finished to close the Comment palette. 

b
 
You can create score-based branching from any page that has a score. For those pages with a 
potential score of three and above, you can create up to three branches. A slider allows you to set 
the parameters of the branches. 

There is another way to use the branching mech
Page. Menu Pages have Link objects that can link to
In this instance, the slider won’t show a score, but the different letters represen
up to j. See the Me u Page section (4.13.1) to see how these letters are assignen

Th
 
Click Sequence Activity to open the Sequencer.  
 
 
 

1. Decide which page is going to be the first page in the activity.  
2. Drag the first page from the page tray into the box marked ‘Drag the 

first page of your activity here’.  
3. Now decide which page will be your second page and drag that onto 

the Seque
4. Join the two pages together; click the anchor at th

page and, holding the mouse down, drag the connecting line to the 
anchor at the top of the second page and release the mouse button. 
This is your branch line. 

5. Drag a third page onto the sequence (eith
). 
nother branch line t
n add comments to a connecting line. In the Comments and Reports panel, click the 
ents icon, hold the mouse button down and drag the object to the connec
 the mouse button. The Comment palette displays. 

Within the p

user to see their current score.
score is not shown by default

 Allow try again – selecting t

complete the 

by default.  
 You can also type some feedback text 
into the box. 
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9. When you ha  a report to the end of it. In 
the Comment nd Reports panel, click the Report icon, hold the mouse button 
down and drag the object; release the mouse button to drop the report object 
below the branch.   

ave multiple 
ne branch. A 

ranches based on choices, not scores.  

 

dd feedback comments to a branch – allows you to add comments to a branch 

 a final report to a branch. 
ct onto the Sequencer and 

The report displays at the end of the 
ctivity and gives the user scores for each page they completed. 

of the Sequencer: 

y. Pages are added to the Sequencer 
ited, and include comments and 

agnifying bar – simple slider bar allowing you to 
agnify the sequence. Dragging to the left reduces 
e size and dragging to the right enlarges it.   

s – allows you to display all pages in the sequence on the screen at the 

ou to restore the display back to default size. If no page is 
lected, the canvas scales from the centre. 

ve a completed branch, you can add
s a

10. Connect the last page of the branch to the report with a branch line. 
 
The way your activity flows is entirely up to you. All pages which have a score can h
branches. Those which don’t, e.g. Flashcards and Information pages, can only link to o
Menu Page can have multiple b
 
The following tools are available in Sequencer: 

 
In the Comments and Reports Panel: 
 

 
A
line in the Sequencer. Click the object, hold down the mouse and drag the object 
onto a branch line. You can add comments via a pop-up palette, and also select 
whether to allow the user to try the page again and/or show the score they 
achieved (see point 7 above). 
 
Add a report to the end of a branch – allows you to add
Click the object, hold down the mouse and drag the obje
connect it to a branch using a branch line. 
a
 
At the base 
 
Create linear sequence – allows you to make a linear sequence of pages, in the 
same order as they are shown in the page tra
in a vertical line. The sequence can still be ed
reports, as with any other sequence. 
 
M
m
th
 
Show all page
same time. 
 
Display 100% – allows y
se

Recycle bin – click this to delete selected objects. 
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Lower panel: 
 
Back to Edit – allows you to go back to the page editor to make changes to 
specific page content.  
 
 
Run Activity – once the activity has been sequenced, click to run through the 
activity as the student will see it. 

s, i.e. two branches = one slider, three branches = two sliders. If 
 branched page is deleted, the slider updates accordingly. If only a single branch is left, then the 

lect it, 
then click the Recycle bin icon. 
 
Looping branch lines – you can drag branch lines upwards in the sequence to create a looping 
sequence, for example if you want a user to repeat a page to get more practice. You do this in the 
same way as other branching lines, but the line goes up vertically and into the top anchor of the 
page you want the user to repeat.  
 
Note:  You cannot create a looping branch line which connects back to the very first page. 

 
 
 
 
Within the Sequencer:  
 
Slider – when you add multiple branches from a page, a slider displays. The slider 
automatically includes the correct number of points for the page. You can make 
a maximum of ten branches from a single page. The number of sliders on a bar 
depends on the amount of branche
a
slider is removed. 
 
Branch lines and anchors – each page added to the Sequencer has a top and bottom anchor, 
allowing it to be linked from and to another page/s. To branch pages, drag the branch lines from a 
bottom anchor to a top anchor. Lines can be selected individually. To delete a line, click to se

 
You can also scroll around the Sequencer area by clicking in it and then, keeping the mouse button 
down, moving from left to right until the pages of the activity you want to work on are in view. 



 
 

© 2008, 3T Productions Ltd and RM Education plc                                                                                         Page 37 of 42 
 
 

6. Playback 

6.1. Splash screen 
The first thing a user sees when they run an activity is a branded 
splash screen, which displays the activity title. The splash screen 
displays until the user is ready to begin and clicks the Start 
button.   
 
The splash screen also displays optional copyright text if this has 
been defined in Activity Set-Up. 
 
 

 
If Request user name was selected during Activity Set-Up, the activity 
playback determines whether the activity is running in a Virtual 
Learning Environment (VLE) or not. If it is, the user’s name is retrieved 
from the VLE SCORM runtime system. If not, an edit box displays, 
prompting for the user’s name. The user then types their name in the edit box and clicks Enter. The 
user’s name displays in the final report screen if included in the activity. 
 
If Request user name was not selected for the activity, the activity will run without checking or 
prompting for a user’s name. 

6.2. Activity toolbar 
The activity toolbar displays at the bottom of every activity page. It may present the following 
buttons to the user, depending on the selections you made when creating your pages.  
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Information – displays help instructions text for a page in a pop-
up box, if you created help/instructions text for a page in the 
Page Editor. The Help pop-up can be closed by clicking the OK 

button. 
 
Print – prints a screenshot of the current page exactly how it is 
shown onscreen along with the user’s name (if applicable). 

 
Reset – prompts the user to confirm that they want to reset the page. If the user agrees, 
then the page reverts to its original state. Any scores and attempts previously achieved are 
not reset. 

 
Next – this button becomes available once the page is complete (i.e. when an 
answer has been selected for a question page). The user is then presented with the 
next page as defined by the Sequencer. 
 
Back – this button displays if you ticked the Show back button option in the Page 
Options panel. The user can navigate back to the previous page. 

6.3. Comment 
The Comment pop-up box is an optional feature that displays when a 
page has been completed. The pop-up can contain comments 
(written by you) based on the user’s performance. It can also show the 
user’s score and allow the user to try the page again, if you have 
selected those options. 
 
Comments relate to a page outcome, rather than the page itself, so 

they can be tailored to a user’s score – giving positive feedback and/or suggesting ways to improve 
their performance. 

6.4. Activity Report 
An Activity Report displays at the end of an activity if it has been added to the sequence. The report 
contains the user’s name, the activity title, a list of the pages that the user completed and the 
scores they achieved on each page.   
 

For each page the user completed, the 
following information will be provided: 

• Page title 
• Page subtitle 
• Thumbnail image of the page 
• Score on first attempt 
• Number of attempts made 
• Score on last attempt 
• Text added by the user (if the page 

contained an Input text box) 
 
The report can be printed by the user, but it cannot be saved.   
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6.5. Printing and saving 
As well as being able to print out their final report, a user can also print any page of an 
activity by clicking the Print icon on the activity toolbar. This prints a screenshot of the 
page, including the user’s name if they provided it. 

 
Please note, in both cases, that the user is only able to print to their own installed printers. The user 
cannot generate a PDF, JPG or other file to save their results unless they have an appropriate 
pseudo-printer installed. 
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7. Saving your activity 

7.1. Saving a Fuse Creator™ file 
Your Fuse Creator™ activity file can be saved at any time by following these steps:   
 

1. From the File Menu click Save. 
2. If this is the first time you have saved the file, the Save FC file dialog box 

displays. Select a location for saving the activity and provide a file name for 
the activity. Click Save. 

3. The activity will be saved as an .fc file (e.g. geog_activity.fc). 
4. You may save the activity at regular intervals by clicking 

Save from the File Menu. You are not prompted to repeat 

or™, from the Start page, 

c. from the File Menu, choosing Open Activity, then selecting the .fc file from the list of 
le files. 

ou may find that you want to save an activity under a different file name so that you can make 

e 

 file 

 file (e.g. 

4. n of the activity at regular 

5. ned in a number of ways: 
a. by double clicking it 
b. by opening Fuse Creator™, choosing Edit from the Start page and selecting the 

 
Please note that .fc files can only be opened for editing by Fuse Creator™. In addition if you have 
Fuse Player you can play back the activities in a .fc file.  In order to allow users to play activities over 
the Web or in a VLE, you must publish the activity or create a SCORM pack (see section 8). 
 

step 2 each time. 
5. Your .fc file can be opened in a number of ways: 

a. by double-clicking on the file in the folder 
b. by opening Fuse Creat

clicking Edit and selecting the activity from its 
location 

availab

7.2. Save As... 
Y
small differentiations in the content or structure. To do this, follow these steps: 
 

1. From within an existing activity, from the File Menu, choos
Save As... 

2. The Save FC file dialog box displays. Select a location for 
saving the new version of the activity and provide a
name for the activity. Click Save. 

3. The activity is saved as an .fc
geog_activity_term1.fc). 
You may save this new versio
intervals by choosing Save from the File Menu. You do not need to repeat step 2 each time. 
Your .fc file can be ope

activity from its location 
c. from the File Menu, choosing Open Activity, then selecting the .fc file from the list of 

available files. 
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8. Publishing activities 

8.1. Publish Standalone 
This feature allows you to create a standalone activity for use on a web page, or 
embedded within another application such as Fuse Publisher™, Microsoft® 
PowerPoint® or Easiteach®.   
 
The following steps guide you through the process of publishing a standalone 
activity. 
 

1. From the File Menu choose Publish Standalone… 
2. The Browse For Folder dialog box displays. Select a location for publishing the activity to and 

click OK. 
3. The activity is published in a folder which takes the same name as 

your .fc file at the location you selected. 
4. Change the folder name to be something relevant to the activity. 

• The activity will run in a browser window if you double-click 
the index.html file. 

• The activity will run in an Adobe ® Flash ® Player window if 
you double-click the index.swf file. 

 
 
 
Note:  Both index files need the subfolders in order to work, so if you move the activity, make sure  
 the subfolders are also moved to the new location. 

8.2. Export SCORM  
This feature allows you to publish the current activity as a SCORM pack for use in a Virtual Learning 
Environment (VLE). 
 
The following steps guide you through the process of creating a 
SCORM pack. 
 

1. From the File Menu choose Export SCORM. 
2. The Select SCORM Format dialog box displays. 
3. You need to choose a SCORM version (either SCORM 1.2 or SCORM 2004). Click the 

appropriate button. 
 

Note:   Most VLEs support the 1.2 standard. 
 

4. An Export SCORM Package dialog box displays. Select a 
location for the SCORM pack, type a suitable file name, then 
click Export. 

5. The Export SCORM Package pop-up box displays, confirming 
that the SCORM pack has been exported successfully. Click 
OK. 
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8.3. Import SCORM 
This feature allows you to import the content of a SCORM pack that has previously been created in 
Fuse Creator™.  
 
To import a SCORM zip file: 

1. From the File Menu, choose Import Activity. 
2. An Import SCORM dialog box displays, where you can navigate to the zip file. 
3. Click Import.  
4. The Import Activity dialog box displays. Select the activity 

by first clicking Manifest Structure, and then navigate to the 
activity file. Click Add. 

• If there is a copyright notice set for the activity, the 
Copyright dialog box displays. Click Accept to 
import the activity. The activity will not be imported 
if you choose to Decline. 

• If the SCORM zip file contains only one activity, then 
it is imported automatically. 

 
 

Note:   If you have an activity already open when you choose to import, you are prompted to save 
the activity before the import completes. 
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